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Class summary 

Become more effective with Autodesk Showcase software and bring your presentation to the next level. This class 
covers advanced topics as well as tips and tricks with Autodesk Showcase. If you are a beginner user, be prepared for 
a class that is fast paced and created for intermediate to advanced users. Come and learn Autodesk Showcase 
directly from the Autodesk technical marketing manager.  

Learning Objectives 

At the end of this class, you will be able to: 

 Embellish your shots with camera tilt, depth of field, and bloom effects. 

 Create and add animated behaviors to storyboard slides. 

 Import objects - animated or not -from other sources  

 Use the software in a creative way, work faster, and understand how to use the software to 
your advantage. 

About the Speaker 
Marion Landry has over 16 years of experience in Architectural Visualization, working with a wide range 
of software including Autodesk® 3ds Max® Design and Autodesk® Showcase™ software. She has worked 
for various architecture firms in Vancouver, BC on numerous projects from concept design to high-end 
visualization. As a Technical Marketing Manager for Autodesk, she focuses on the creation of technical 
demonstrations and workflows with Autodesk® 3ds Max® Design and Autodesk® Showcase™ products. 
She also contributed in the writing of multiple white papers including: Daylight Simulation in 3ds Max 
Design 2009 (Getting started and advance), Using the Autodesk Civil Visualization Extension for 3ds Max 
Design and AutoCAD Civil 3D and more recently Easier mental ray rendering for designs workflows. You 
can follow Marion’s technical advices and tips and tricks publication on twitter and on her YouTube 
channel.  She also answers technical questions and offer support on The Area Autodesk Showcase 
forum.  

http://images.autodesk.com/adsk/files/3dsmax_started.pdf 
http://images.autodesk.com/adsk/files/3dsmax_advanced.pdf 
http://images.autodesk.com/adsk/files/mental_ray_white_paper_2012_en.pdf 
http://images.autodesk.com/adsk/files/civil_whitepaper.pdf 

http://images.autodesk.com/adsk/files/3dsmax_started.pdf
http://images.autodesk.com/adsk/files/3dsmax_advanced.pdf
http://images.autodesk.com/adsk/files/mental_ray_white_paper_2012_en.pdf
http://images.autodesk.com/adsk/files/civil_whitepaper.pdf
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You tube channel @LandryMarion 
Twitter @MarionLandry 
Facebook page: @ Autodesk Showcase 
The Area Showcase Forum: http://www.the-area.com/forum/autodesk-showcase/ 
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Tips #1: Inventor workflows overview 
Some challenges exist with the Inventor workflow in terms of file size. Often the Inventor projects are 
large and can include millions of objects (or thousands of parts). It is suggested to organize your project 
first in Inventor before sending it to Autodesk® Showcase™.  Below few suggestions you might want to 
consider: 

 Consider importing parts of your model first and at a later time, the complete assembly. 

 Clean up your model of unnecessary objects (parts) that you won’t need for the visualization. 
Keep in mind that hidden objects will import as hidden object in Autodesk® Showcase™.  

 Import your objects at a low level of tessellation first in Autodesk® Showcase™. You can always 
increase the level of detail later on in Autodesk® Showcase™. Refer to tips #6 

 Be patient during the import process while Autodesk® Showcase™ tessellates the millions of 
objects included in your scene.  

 If you have imported a model that includes constraint, DO NOT MOVE, ROTATE OR SCALE the 
model once in Autodesk® Showcase™. This will break the behavior.  Instead, re-orient the model 
properly under the import status window. Refer to tips #5 
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Tips #2: Set-up the Inventor scene before exporting the data to Autodesk® 

Showcase™. 
It is important to understand the organization of the Inventor project as it affects the way it will be 
imported in Autodesk® Showcase™. Here are few tips to keep in mind. 
 

 If you are planning on exporting Inventor constraints, make sure they are “drivable” and that 
they work properly. The exact naming (case sensitive) of each constraint will be important for a 
successful import in Autodesk® Showcase™. 

 Have a look at your design view representations. The way they are setup will be translated into 
Autodesk® Showcase™ Storyboard slides, shots and alternatives.  Activate the view 
representation you want your model to first appear in Autodesk® Showcase™ before sending 
the data to Autodesk® Showcase™.  
 

Tips #3: Suite Workflow from Inventor> One-click button 
From Inventor, go to the Main menu> Suite workflows. Three options are offered to you: 

 
Depending on the option you choose, the export setup menu will have pre-selected settings. If you want 
to export Inventor constraints, it is recommended to use the “Showcase Constraint Animation” option.  
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Before you run the export, always check the “Settings” to make sure they correspond to what you need.  
   

1. Geometry:  Adjust the level of detail (tessellation of Showcase) upon import.  Refer to tips #6 
2. Visual Style: Choose which visual style will be displayed in the Showcase viewport upon import. 
3. Light Style: It is recommended to leave this setting as is and, make the adjustment once in 

Autodesk® Showcase™. 
4. Object Animation: You will need to have this option turned “on” if you plan to import 

constraints. If this option is turned on, when clicking the “Run” button, you will be prompt with 
constraint selection window. 

 
Click on the selection icon and navigate to the drivable constraints in your Inventor scene to select it. 
You can select multiple constraints. The Showcase Conceptual Model window will list the constraints 
that will be exported.  
 
 
Click “continue” once you have selected all the Inventor constraints you want to import. The 
export/import process will start.  
 
Autodesk® Showcase™ will launch automatically and will import your scene, depending on the scene 
complexity and the level of detail you have selected, the translation process might take a while.  
 
**Review the suite workflow steps in a YouTube video: http://youtu.be/WISYIe71Du8 

Tips #4: Importing an Inventor model directly from Autodesk® Showcase™ 
It is also possible to import Inventor models and constraints directly from Autodesk® Showcase™.  
 
To do so, go to the Autodesk® Showcase™ main menu File>import>Import files… 

 
 
Similarly to the Suite workflow, you will want to verify the import settings first. Browse to the Inventor 
.iam or .ipt file you want to import and click on the “settings” button from the import file(s) window. 
 

1. File format: In this case, you want the file format to be (IAM,IPT) files.  
2. Geometry section: choose the level of detail. Refer to tips #6 

http://youtu.be/WISYIe71Du8
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3. Shots section: This option will create additional Autodesk® Showcase™ shots on import. You can 
choose various shots from the list. 

4. Animation section: If you are planning to import Inventor constraints, you will need to check the 
option “create behaviors from constraints” and write the name of the Inventor constraint you 
are importing. It is really important to write the EXACT name (case sensitive) as it appears in 
Inventor (any spelling mistake stop the constraint from being imported.)  I suggest you copy the 
constraint name from Inventor and paste it in this window. Click the plus sign (+) button to add 
more than one constraint. 

5. New Scene Lighting Style section: I suggest you leave it to the default “Empty”. It will be easier 
to change the environment once you are in Autodesk® Showcase™ and received visual feedback 
of your choice.  

Close the setup menu and click import.  
The Inventor Assembly Settings will open and you will need to browse to the Inventor Project file. This 
will help Autodesk® Showcase™ to find the entire Inventor components needed for the scene.   
 
 
**Review the import Inventor constraints process from Autodesk® Showcase™ in a YouTube video: 
http://youtu.be/grOHD0l349g 

Tips #5: Changing the orientation of a model after import  

 
It is possible that your Inventor model import with the wrong orientation. This is due to the fact that 
Inventor viewport is using the Y axis up where the Autodesk® Showcase™ viewport uses the Z axis up.  
You first instinct will be to rotate and/or move the object. This is wrong and will break the behavior 
functionality. The proper way to re-orient the model is within the import status window.  
 
Go to the File menu > Import >Import Status or press “I” on your keyboard to open the Import Status 
window.  
From the Import Status window, highlight xxx.iam file (or any other imported file) and right click > 
Model properties 
 
Change original Up-axis to Z-up. This should fix the problem. 

http://youtu.be/grOHD0l349g
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**Review this tips & tricks in a YouTube video: http://youtu.be/RzXN4zWYMJc 

Tips #6: Adjusting the level of detail of a model after import 
**Tessellation is the process of subdividing a surface into smaller polygons (shapes) for rendering. The smaller the polygons will equal in a 
more accurate appearance but will impact on performance.  

 
Levels of Detail (LODs) are the different depths of tessellation that can be used for CAD (computer-aided 
design) models. Typically, LODs vary from low-fidelity (larger polygons, poor surface quality, and high 
rendering speed) to high-fidelity (smaller polygons, excellent surface quality, but may take time to 
render).  
For example, the sphere in the following illustration is displayed, from left to right, with low- to high-
fidelity LODs.  
 

  

http://youtu.be/RzXN4zWYMJc
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When importing a model in Autodesk® Showcase™, by default, the LOD is set to “All purpose” which is 
set to give great rendering quality model but can impact the performance of Autodesk® Showcase™.  Re-
adjusting the level of detail will help you balance the performance vs quality. If you are dealing with a 
very heavy model, it might be a good idea to reduce the level of detail for the first import. This will 
reduce the density of the mesh (tessellation) in Autodesk® Showcase™ and therefore the translation 
(import) time. It will also lighten the scene. You can always convert your model to a lower/ higher level 
of detail after the import process.  
 
 

To re-adjust the level of detail after import, open the Import window by pressing “I” on your keyboard. 
Right click on the conversion setting and choose the appropriate level of detail.  

 
 

**Review this tips & tricks in a YouTube video: http://youtu.be/ea-nGZDP4Cs 
 

Tips #7: Adding Behaviors (Inventor constraints) to a storyboard slide 
Once you have imported an Inventor constraint to Autodesk® Showcase™, it becomes a Showcase 
Behavior. You can access it from the Behavior menu. (press the letter “b”on your keyboard)  
 
To play the behavior (constraint), use the playback button on the behavior menu 

  
This menu will control the playback of all behaviors at the same time. 
To play the behavior individually, right click on the behavior icon and choose the option>Unknown 
Controls for nameoftheInventorconstraint 

http://youtu.be/ea-nGZDP4Cs
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This will open an individual playback from which you can play the behavior individually.  

 
 
Because every constraint animation is different, the way you can use them in your presentation will 
vary. The principle is the same; you need to add the behavior to a storyboard slide and decide how to 
play the behavior. 
 
To add the behavior to a storyboard slide, right click on the behavior icon and choose > Add to 
storyboard slide, and then choose the playback action.  

 
 
You can add multiple actions per behavior in each storyboard slide.  
 
**Review this tips & tricks in a YouTube video: http://youtu.be/b4tk4meTlEE 
 
 

http://youtu.be/b4tk4meTlEE
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Tips #8: Setting the floor position 
During the import process, according to the setting you have chosen, the environment ground plane 
level will be set at either the bottom of the model or at the level set in the Inventor project. You still 
might want to move the ground plane position. To do so, go to  
 
Main menu Edit>Set Environment floor Position. You can adjust the floor position within this window.  

 
 

Tips #9: DWG workflows overview 
If you own any of the Autodesk Suite that includes AutoCAD, you can load 3D DWG model directly in 
Autodesk® Showcase™. The easiest way is to load the one click suite workflow from AutoCAD. Below are 
few things to keep in mind when doing so.  
 

 If you are dealing with a large model it might be a good idea to Import multiple DWGs (one per 
major component) 

 On import, Autodesk® Showcase™ will zoom extended to the entire scene. So if you have a tiny 
object in a far corner of your project that you no longer use, Autodesk® Showcase™ will include 
that object in the import and zoom extend the view to include the tiny object… So you might 
want to make sure that your DWG is clean of unwanted object before export/import.  

 Keep in mind that Autodesk® Showcase™ keeps an active link to AutoCAD (as well as Inventor or 
Revit for that matter) You have the possibility of updating your model as the design evolve in 
AutoCAD. Have a look at this video created by Jonathan Landeros to understand the principle 
behind. http://youtu.be/leWnF9xm6sE 

 When using DWGs it is possible that the surface Normals (Orientation of polygonal faces), once 
in Autodesk® Showcase™, might be wrongly oriented. Applied materials will look best when the 
normal are facing towards the viewer/camera. It is suggested to diagnose your model 
immediately after import to fix the normal orientations. To do so, open the Visual Style window 
(press “v” on your keyboard), Open the Diagnostic Tab and choose the Normals style or press f7. 
Every face that is showing in yellow is facing away from the camera. Press F8 to reverse the 
faces. Look at this tips and tricks recording to understand better. http://youtu.be/eIrRIR4U4HI 

 Keep in mind that the objects that have wrong UV and display improper textures in AutoCAD will 
be the same once imported to Autodesk® Showcase™. Fixing the objects UV in AutoCAD might 
be a challenging job but it is something really easy to fix in Autodesk® Showcase™.  The easier 
work around in Showcase is to use Showcase Materials with “Tri Planar mapping type”. Review 
these two videos to understand how to use Showcase Materials http://youtu.be/flxxxUCuVGA 
and http://youtu.be/KkED6Ujp_NE 

http://youtu.be/leWnF9xm6sE
http://youtu.be/eIrRIR4U4HI
http://youtu.be/flxxxUCuVGA
http://youtu.be/KkED6Ujp_NE
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Tips #10:  Adjusting camera clipping planes 
Often when you are working with large size model or scenes, you will notice a great amount of flickering 
or black triangle effect on your model. The scene will have millions of black flashing triangle and will be 
buzzing when orbiting/navigating around. This is caused by the camera clipping plane distance being too 
short causing difficulties for the camera to identify the order in which to display the polygons or faces. 

 
To fix it, go to file menu>settings>scene settings. From the Scene Settings window, increase the near 
clipping plane distance amount.  The distance amount will depend on the type of scene and the distance 
of the camera from the object it is viewing. So, if you have views that are really close to your objects 
combine with views that are really far from the objects, you will need to find the correct ratio to avoid 
clipping the objects that are close from the camera. 

 
 
**Review this tips & tricks in a YouTube video: http://youtu.be/PBMMg8PEPzU 
 

http://youtu.be/PBMMg8PEPzU
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Tips #11: Revit workflows overview 
Although the data exchange between Revit and Autodesk® Showcase™ is relatively clean, the biggest 
challenge with this workflow is the size of the Revit scenes. Most Revit scenes include millions of objects 
which will take several minutes for Autodesk® Showcase™ to import. Once in Autodesk® Showcase™ you 
might have a low frame per second (slow refresh rate.)  When dealing with large Revit scene, you will 
need to be creative and think outside the box. Here are few tips that might help you.   
 

 Manage the views in Revit first: It might be a good idea to create specific views that will be 
dedicated to Showcase visualization. You should manage the visibility content of these views to 
include only the necessary items. By that I mean, if you are not going to see the plumbing or 
electrical objects of your design, make sure they are not visible in your views before exporting it 
to Autodesk® Showcase™. You can review this video to understand the workflow process: 
http://youtu.be/3cZPMjIAHFY 

 If you are planning to use the FBX workflow, use multiple FBX: It will be easier in Autodesk® 
Showcase™ to manage a complex scene that is built of multiple FBX then one large and heavy 
FBX.  

 Once in Autodesk® Showcase™ work with the organizer: Using the organizer to manage the 
content of your scene can greatly facilitate your experience. Use the organizer to rename, group 
and/or combine objects.  

 Clean up the materials list: The least amount of materials in your scene, the faster the frame 
rate. Avoid any duplicated materials and minimize the amount of materials in use.  

 When you are using the suite workflow button from the Revit application menu, during the 
translation, a FBX is created and linked to Autodesk® Showcase™. Unfortunately, by default, that 
FBX is saved under your TEMP folder and might be hard to retrieved at a later date or if you 
delete your TEMP folder on a regular basis.  
(On Windows 7 it’s here:     C:\Users\<your name>\AppData\Local\Temp) 
To avoid that, I suggest you export the FBX from Revit, save it within the Autodesk® Showcase™ 

project folder where it will be easy for you to find it and then, do the direct import in Autodesk® 

Showcase™. That way, you are sure to keep the FBX in a safe place. Be aware that since 

Showcase 2014 launch, the suggested workflow is now to import native Revit files directly to 

Autodesk® Showcase™. Jump to Tips #13 

Unsupported items  

The following Revit features and elements are not supported in Showcase:  

 2D line work – Plan- terrain lines- parking lines.  

 Lights – All lights will need to be recreated in Showcase 

 Design options are not fully supported  

 Phases are not fully supported  

 Entourage (RPC) is not fully supported  

http://youtu.be/3cZPMjIAHFY
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Tips #12: Scene optimization with AutoGroup Add-Inn  
Large Revit scene can compromise the performance of Autodesk® Showcase™. The display frame rate 
(refresh rate) lag is largely due to the fact that Autodesk® Showcase™ has to refresh a large number of 
objects and materials.  But if you load the AutoGroup Add-in, you can combine and group objects that 
share the same Revit Category, Family, Type and Material which greatly improve the performance of 
Autodesk® Showcase™. 
**Review this tips & tricks in a YouTube video http://youtu.be/ng1HB9bLF4Q 

Tips #13: Importing Revit native file workflow 
Autodesk® Showcase™2014 now supports direct native Revit (.rvt) file import. This workflow is the 

easiest way to keep an active link between Revit and Autodesk® Showcase™ without having to convert 

the Revit file into and FBX.  To have the most efficient workflow, follow these guidelines: 

 For best result and faster import time, save your scene in Revit 2014 before importing.  

 Manage the view in Revit; to exclude unnecessary geometry from the export, hide it using the 

"Hide in view" feature or the Visibility/Graphic Overrides window. Using Temporary Hide/Isolate 

does not exclude geometry from the export. 

 Should you experience performance issues in Autodesk® Showcase™ while working with your 

Revit geometry, consider combining geometry in the Showcase Organizer to reduce the number 

of objects- refer to tips #12 

 Import of multiple Revit files is not supported. If you select multiple Revit files, only the largest 

file will be imported. 

**Review this tips & tricks in a YouTube video http://youtu.be/4mR3dRJIEXc 

Tips#14: 3ds Max Design workflow overview  
It is possible to import 3ds Max models (animated or not) into Autodesk® Showcase™ via FBX. 

Unfortunately, you need to be aware that the FBX 2014 version creates triangulate models once in 

Autodesk® Showcase™, therefore you need to rely on the FBX 2013 export.  

http://youtu.be/ng1HB9bLF4Q
http://youtu.be/4mR3dRJIEXc
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It is best to know in advance that your model will be used in Showcase and build it accordingly. For a detailed 
white paper on this subject from version 2012, see 

http://images.autodesk.com/adsk/files/prepare_max_models_for_showcase_2012.pdf 

General guidelines: 
 
Geometry: 

 NURBS are not supported. Autodesk® Showcase™ will convert polygons into meshes upon 
import and this can cause visual irregularities. Try to convert 3ds Max polygons into meshes in 
3ds Max. Alternatively, you can use the Triangulate option in the FBX exporter.  

 Combine objects that do not need to be independent of each other. This will help speed up 
Showcase. Multi/Sub-Objects (MSOs) are not supported on Autodesk Materials, only on 
standard materials.  

 Reduce polygon count to optimize Showcase performance. Use tools such as the Optimize 
modifer or ProOptimizer to do this.  

Animations: 

 Make sure Animation is selected in the FBX Export dialog box. Transform-based animations 
(Keyframe animation using Move, Scale or Rotate) are supported. Vertex-based animations are 
not.  

 
Cameras: All cameras are supported. Cameras that are animated using Transform-based animations are 
supported. Cameras that are animated using path constraint are not.  
 
Lights: Lights are not supported.  
 
Materials:  

 Autodesk Materials and Standard Materials with regular texture maps are supported. Avoid 3ds 
Max procedural textures and Arch&Design Materials—these are not supported.  

http://images.autodesk.com/adsk/files/prepare_max_models_for_showcase_2012.pdf
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 Use Real-World Scale UV coordinates and set the texture size in current units. Make sure that 
proper UVs are applied—UV modifiers are supported in Autodesk® Showcase™.  

 If you are using standard materials, convert bump maps to normal maps.  

 To achieve good ambient lighting in Showcase, use the Unwrap UVW modifier to generate 
unique UVs in 3ds Max.  

 To successfully import custom texture maps on Autodesk Materials into Autodesk® Showcase™, 
apply the Autodesk Bitmap to them.  

 Procedural maps are not supported, except for those related to Autodesk Materials, including:  
Autodesk Checker , Autodesk Gradient, Autodesk Marble, Autodesk Noise, Autodesk Speckle,  
Autodesk Tiles, Autodesk Waves, Autodesk Wood  

 Scale texture maps in binary multiples for best efficiency (64, 128, 256, 512, 1024, and so on).  

 If you notice that texture maps are not being imported into the Autodesk® Showcase™ scene, 
try enabling Embed Media in the FBX exporter. However, if you do this, texture map links will be 
lost, and the FBX file will be larger.  

Tips#15: Importing an animated camera from 3ds Max Design 
3ds Max Design offers a series of tools to create cinematic like camera animations. If you use any of the 
Autodesk Suite Premium or Ultimate, you have access to 3ds Max Design as part of your suite and might 
want to take advantage of its powerful tools. Creating and adjusting camera animation in 3ds Max 
Design can result in a more refine animation. You can easily export these animated cameras to 
Showcase. To do so, you need to export the animated cameras of 3ds Max Design into an FBX 2013 file 
and import them in Autodesk® Showcase™. Only Transform-based camera animations (Key frame 
animation using Move, Scale or Rotate) are supported. 
 
**you can review this step in this youtube video: http://youtu.be/1Sn04kILIsY and 
http://youtu.be/jgbqv-untFg 

Tips #16:  Import animated objects from 3ds Max Design 
It is also possible to import animated objects into Autodesk® Showcase™. Autodesk® Showcase™ does 
not support Vertex animations, only Transform-based animations using Move, Scale or Rotate. 
Animating objects in Autodesk® Showcase™ is possible but can prove challenging to refine. Refining your 
animation in 3ds Max Design is a simpler action. You need to export the animated objects in 3ds Max 
Design into FBX 2013 file. 
 
**you can review this step in this youtube video: http://youtu.be/yRZwCOJUTdA  and 
http://youtu.be/Gv5LH6No31I 

Tips #17: Import 3ds Max Design Populate characters  
The Populate toolset new to 3ds Max Design 2014 lets you add animated characters to your scene 

quickly and easily. The characters can walk along paths, or "flows," and others can hang out in "idle" 

areas. The flows can be a simple or as complex as you like, and can include shallow inclines and declines. 

http://youtu.be/1Sn04kILIsY
http://youtu.be/yRZwCOJUTdA
http://youtu.be/Gv5LH6No31I


Autodesk® Showcase® 201: Get Creative with Autodesk® Showcase® 

 

16 
 

These characters can be exported to Autodesk® Showcase™ using FBX 2014 format. However, the 

animation of the characters is not supported by Autodesk® Showcase™. With the Custom Skin, Crowd 

Skin, and High Res Skin options, when using 3ds Max, Populate applies a Multi/Sub-Object material 

made up of Standard materials to each crowd member. When using 3ds Max Design, however, the 

Multi/Sub-Object materials applied to the crowd members is composed of Arch & Design material which 

is not supported by Autodesk® Showcase™. To switch from using Arch & Design materials to Standard as 

components of the Multi/Sub-Object material, open the Custom UI and Defaults Switcher and under 

Initial Settings For Tool Options, choose a default that uses the Scanline renderer, such as Max, restart, 

then re-simulate. Watch this video for step by step description.  

**you can review this step in this youtube video:  http://youtu.be/jaZzir4RDw4 

Tips #18: Storyboard, storyboard slides and behaviors; how to tell a story. 
First, let’s understand the terminology 

Storyboards are graphic organizers in the form of illustrations or images displayed in sequence for the 
purpose of pre-visualizing a motion picture, animation, motion graphic or interactive media sequence. 

Storyboards are used today by industry for planning ad campaigns, commercials, a proposal or other 
business presentations intended to convince or compel to action. 

 

Storyboard slides is a thumbnail representation of a group of action, time and transition. 

http://youtu.be/jaZzir4RDw4
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In Autodesk® Showcase™, a storyboard slide allows you to organize in time individual scene items such 

as: Alternatives, shots, behaviors and one environment per slide.  

Behaviors are special items that can be applied to objects in the scene to increase interactivity or show 

motion and function. The available behaviors in Showcase are: 

Types of behavior available in Showcase: 

Keyframe: Keyframe animations are based on object transformations changing over time. Animations 
can be created within Autodesk® Showcase™ by transforming objects (changing their Translation, 
Rotation, or Scale) and setting “keyframes” of each position to keep. Separating these keyframes on a 
timeline determines how fast or slow the object moves from position to position. Refer to tips #22 
 

Trigger: 3D triggers add interactive control and annotations to your scene while in Presentation mode, 

and can be linked together to cause many items to change or activate at once. A trigger makes specific 

objects in your scene “clickable” which can then cause another scene item to be activated in the scene.  

Triggers are created and defined in the Behaviors interface, but can activate behaviors, alternatives, 

shots, storyboard slides and lighting environments. Watch this video to learn more: 

http://youtu.be/KXts7gtEm6I 

Turntable: Is an action that will rotate your model by 360 degrees in your scene (as opposed to having 

the camera rotate around the model). 

Anim: This type of behavior will be created upon import of animated objects. 

**you can review this step in this youtube video:  http://youtu.be/dnH-51sgmT0 

Tips #19: Using Depth of field  
In optics, particularly as it relates to film and photography, depth of field (DOF) is the distance between 

the nearest and farthest objects in a scene that appear acceptably sharp in an image. Although a lens 

can precisely focus at only one distance at a time, the decrease in sharpness is gradual on each side of 

the focused distance, so that within the DOF, the unsharpness is imperceptible under normal viewing 

condition 

http://youtu.be/KXts7gtEm6I
http://youtu.be/dnH-51sgmT0
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In Autodesk® Showcase™ terms, depth of field is the range of distance within the scene that appears 

acceptably sharp in the image. It is suggested to use DOF to improve photorealism and depth 

perception, and to attract attention to a specific object/part. 

Use Depth of field controls as follows:  

 Center of Interest: Sets the focal distance to the current center of interest.  

 Click on an object: Sets the focal distance to an object you click.  

 Focal distance: The distance from the camera to the focus point. (The focus point is closer to the 
camera than the center of the focal range.)  

 F-stop : Determines the depth of the focal range; smaller values have a shallower range and a 
greater blur effect. Larger values have a deeper range and less blur. The F-stop works in tandem 
with focal length. Increasing the focal length (zooming) reduces the focal range and increases 
the blur. Ray tracing has more accurate depth of field and the ability to blur more. Hardware 
rendering blurs less to keep a higher frame rate.  
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Bloom, compensation, and depth of field can be saved with Shots. However, you can choose whether or 

not you want them to affect the playback of a given shot by selecting or deselecting the option in the 

Shots Properties window. 

To learn more about DOF, watch this 3 parts tips and tricks videos 

DOF Part 1: In this video, learn how to add DOF in the viewport and save it to your Showcase Shots: 

http://youtu.be/L-qwERL2OuY 

DOF Part 2: In this video, learn how to use DOF in combination with Ray Tracing: 

http://youtu.be/BYSdJNE6iNo 

DOF Part 3: In this video, learn how to include DOF in an animated shot: http://youtu.be/CTpwRcHAYN4 

Tips #20: Adding camera tilt 

  

 

Adjusting the camera tilt angle for each individual shot can create creative angle and help customize 

presentation to your need. To add camera tilt, go to View menu>Camera Properties… and adjust the 

camera angle under the position tab. 

http://youtu.be/L-qwERL2OuY
http://youtu.be/BYSdJNE6iNo
http://youtu.be/CTpwRcHAYN4
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Tips #21: Adding camera lens effect: bloom 
Bloom (sometimes referred to as light bloom or glow) is a computer graphics effect used in video games, 

demos and high dynamic range rendering (HDR) to reproduce an imaging artifact of real-world cameras. 

The effect produces fringes (or feathers) of light extending from the borders of bright areas in an image, 

contributing to the illusion of an extremely bright light overwhelming the camera or eye capturing the 

scene. 

Bloom effect in Autodesk® Showcase™ and other 3d applications 
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In Autodesk® Showcase™, you can add bloom as a camera effect. Keep in mind that Bloom effect is not 

supported in ray tracing mode. 

To add bloom effect you need 2 things: 

1. A self-illuminated materials such as: Autodesk Material Glass-Light bulb on  

2. Enable Bloom effects under the Camera properties 

**you can review this step in this youtube video:  http://youtu.be/W1CLgsajBQw 

  

http://youtu.be/W1CLgsajBQw
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Tips #22: Creating a Keyframe animation 
Keyframe Animations can be created within Autodesk® Showcase™ by transforming objects (changing 

their Translation, Rotation, or Scale) and setting “Keyframes” of each position to keep. Separating these 

Keyframes on a timeline determines how fast or slow the object moves from position to position.  

 

Keyframe Animations require that two “key frames” be defined for an animation to occur. The 

animation is the automatic interpolation of an object between two or more positions in space (with 

Translation, Rotation, and Scale). 

In Autodesk® Showcase™, you can create two types of animation (Keyframe animation and Turntable) as 

well as import animations from an FBX file. They both reside within the behavior menu.  

 

Limitations: 

 All transforms are keyed at once. 

 Rotation greater than 180 degrees: Keyframe animation works by finding the shortest distance 

between keyframed positions and orientations. In cases of rotation, this can mean that the 

shortest distance is actually the reverse of the direction the object was originally rotated. 

 Relative speed: The common Playback Controls include + (plus) and - (minus) buttons to adjust 

the speed of playback. Once these are used, the per-second notations on the timeline lose their 

absolute timing, but retain their relative distance to each other. In other words, the animation 

speed has become relative. I strongly suggest to stay away from the relative speed has it get’s 

confusing really fast and in to reset it, you will need to restart Showcase all together.  
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**you can review this step in this youtube video:  http://youtu.be/VM3gh_08M9I 

Tips #23: Moving the pivot point of an object. 

When you start creating animation for your objects you will most likely need to adjust the pivot point to 
have your object rotate or scale to your need. Transformations occur relative to the pivot point of the 
selection. In other words, the pivot of an object is where any Translate, Scale or Rotation applied to that 
object will start from. By default, the pivot is at the spatial center of the object, which is also where the 
Transform Handle is shown. Moving the pivot is useful for rotating objects on an arbitrary axis (such as 
doors) or scaling from an edge. Moving the pivot point of an object can be done really easily in 
Showcase. 

The pivot handle will replace the Transform Handle in the scene.  

**you can review this step in this youtube video:  http://youtu.be/D93ef0Ysh-o 

Tips #24: Ray tracing overview  
Why use ray tracing over hardware rendering? The main reason is that Ray traced images are higher 
quality and more realistic. Ray tracing produces highly realistic visuals by tracing “rays” from each 
rendered pixel into the 3D scene, which then bounces, bends and creates visual effects similar to real 
light. Ray tracing uses computer processor (CPU) so the number and speed of processors influences the 
performance.  Ray tracing mode can be both interactive or offline for output. 
 
Ray tracing can add many new effects that are impossible to achieve with Hardware rendering: 
-Ray traced reflections and transparency 
- reflection 
-Refraction 
-Absorbance 
-Ray traced shadows 
-Ray traced ambient shadows 
-Global Illumination 
 

http://youtu.be/VM3gh_08M9I
http://youtu.be/D93ef0Ysh-o
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Reflection: Ray traced render                                         Reflection: Hardware render 
 
Some Autodesk Materials such as Glass and Metals will only render well under ray tracing mode 
For example: 

  
Ray traced Autodesk Material: Clear glazing              Hardware render Autodesk Material: Clear glazing     

                                
Ray traced Autodesk Material: Aluminum                Hardware render Autodesk Material: Aluminum 
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Below are advantages and comparison between both rendering modes. 

Hardware  Ray tracing  

Uses the GPU (video card) to calculate and display 

the scene.  

 

Uses the CPU (computer processors) to calculate 
and display the scene. 

Very fast response time (frames per second) on 

qualified hardware.  

 

Very high quality visuals, with realistic shadows, 
transparency and reflections. 

Easy to manipulate objects, materials, textures and 

cameras due to response time.  

 

Enhances environments, accent lights and 
materials with new properties and capabilities. 

Very fast image and movie output at large 

resolutions.  

 

Can be optimized for interactivity or final output 
quality. 

In hardware rendering, the type and memory size 

of the video card influences performance. 

With Ray tracing, the number and speed of 
processors influences performance. 

 

 There are two Ray tracing mode in Autodesk® Showcase™, Interactive and render mode.  

 Interactive Ray tracing can progressively improve in quality whenever the scene is static.  

 Advanced Ray tracing effects can be selectively added and controlled using presets in the 

Performance and Quality window 

Tips to improve interactive performance: 

1. Reduce the Showcase window size. Ray tracing is based on tracing rays from each pixel of the 
image, so reducing the number of screen pixels will increase the frame rate and any progressive 
refinement of the image on screen.  

2. In the Options > Selection Display Style menu, select a “wireframe” display method. The 
“animated grid” will prevent progressive refinement.  
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3. Move the view away from areas with lots of transparent and refractive surfaces. Transparent and 
inter-reflective objects will require more rays per pixel than other objects in the scene, and will 
reduce performance when they are dominant in the view. 

4. As a personal note, here is how I adjust the Interactive Ray Tracing panel for most of my scenes: 

 I normally play with the interactivity slider to increase quality or speed depending on the scene. I 
then open the Advanced Settings panel and lower the desired trace depth to 3. Unless there are 
MANY (3 or more) layers of glass I am trying to see through. This setting will show mainly on glass 
transparency and metal. I also change the filtering mode to BOX which is faster and sharper. Then 
I let it render forever…  
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Tips #25: Tips to output images with Ray Tracing  
Rendering an image using Ray Tracing mode will give you better quality and more accuracy at the 

material, light and shadow level. Personally, 90% of my quality images are created using ray tracing. 

Unless I am in a rush (Hardware rendering is MUCH faster) I use ray tracing.  

Ray Tracing image formats  

JPEG: Joint Photographic Experts Group format. Common format used for web and email. Small file size, 

but can show compression artifacts.  

BMP: Bitmap format. Common Windows image format.  

HDR: Radiance RGBE format. Contains greater brightness, contrast and color ranges than other file 

formats, but has limited compatibility with most image editors. Preserves highlights and shadows 

beyond what is displayed on screen.  

 

***Note :HDR images may appear to have less contrast or be lighter than the image viewed interactively on screen. This is due to limitations in 

the image editor software. Because the file format contains more dynamic range than most monitors can show, many image editors display HDR 

images without monitor gamma correction or any tone mapping. To achieve the same visual results, either tone map the image to an LDR or 

force gamma correction on display.  

TIFF HDR: Variant of TIFF that contains greater brightness, contrast and color ranges than other file 

formats, but has limited compatibility with most image editors. Preserves highlights and shadows 

beyond what is displayed on screen.  

TIFF: Tagged Image File Format. Common format used for publishing and archiving. Larger file size, but 

without compression. (this is the format I use in most case scenario. I prefer reducing the file size after 

rendering if needed for web or emailing purposes) 

***TIFF images (both regular and HDR) will include an extra “alpha channel” that is a grayscale mask of the objects in the scene, with 

transparency, to separate them from the environment or background colors.  

To output an image, this is how I go about it: 

1. Press R to activate Ray Tracing mode 

2. Open the settings- Crank up the Interactivity to 100 quality 

3. Open the Advanced settings panel, crank the precision to 1, change the filter to Gaussian (it will 

give you a smoother looking image) and uncheck the precalculated ambient shadows (this 

means that the ambient shadow will be calculated within the ray traced mode and be more 

accurate than any pre-calculated ambient shadow you might have previously calculated) 

4. Let the image render forever and save it as a TIFF image once you are satisfied with the result.  

5. If you need to output the image using the publish menu: Set save as: to tiff, increase the 

resolution to 300 DPI (you never know when you will need to print this image so better be 
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prepared), check on anti-aliasing and crank it to high, check the “add alpha” (this will give you a 

separate layer in photoshop) and publish you image.  

 

Tips #26: Saving and re-using Ray tracing Settings 
It is possible to save the settings of your ray traced image. You can do so within the Interactive Ray 

Tracing tab of the Performance and Quality window as a preset.  This is a good way to preserve 

temporary modifications to other presets (denoted by a * in front of the name), or to create presets 

based on computer capabilities or special needs. When saving your ray traced images, an .xml file gets 

automatically created that contains the rendering preset associated with this particular image.  

 

By default, Showcase sets the save folder as \Documents\Autodesk Showcase 

2014\InteractiveRaytracingSettings\. Preset files saved to this location are automatically available to you 

in the Quality preset drop-down box near the top of the window, as well as the Publish window.  
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Presets saved to other locations will not be loaded by Showcase unless they are moved to the default 

location.  

To share a custom preset with another Showcase user, copy the XML file to their 

InteractiveRaytracingSettings folder.  

**you can review this step in this youtube video:  http://youtu.be/dVcYaXbNMiY 

Tips #27: Working with Accent Lights 
Accent lights are independent sources of Illumination in your scene. They can be used to create 

highlights, dramatic lighting, or emphasize important parts of your model. Accent lights are object that 

need to be position in your scene. They will also need to be associated with object in order to illuminate. 
They will only cast shadow under the Ray tracing mode.  
 
Autodesk® Showcase™ has two types of Accent Lights: 
Selective Spot light: this light sends one direct light in a triangular shape)  
Selective point light: this light sends light in all direction in a ball shape).  

http://youtu.be/dVcYaXbNMiY
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The shadow of the accent light will only display under ray tracing mode 
  

    
Accent lights with hardware rendering mode     Accent lights and Shadow with Ray tracing mode 
 
**you can review this step in this youtube video:  http://youtu.be/vhUhT5_pYSM 

Tips#28: Understanding the difference between publishing a shot or a 

storyboard slide. 
You can create a movie from shots or a storyboard slides and might not be aware of the differences. 

When publishing a movie from shots, the movie will be saved as it is displayed within the viewport. That 

means that no behavior can be saved in this movie and it will use the active environment, alternatives 

and visual style.  

When publishing a movie from a storyboard slide, it will save the movie of your slide. That means 

whatever elements (environment, alternative change, behavior and shot list) that is included in that 

particular slide will be output as one movie. Keep in mind that whatever visual style is loaded in the 

viewport will dictate the visual style of the movie output.  

Be aware of the following regarding video creation:  

http://youtu.be/vhUhT5_pYSM
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 If you are using the 64-bit version of Showcase, 32-bit video codecs will not work.  

 Windows AVI files cannot be bigger than 2 GB. For more information, see 

http://support.microsoft.com/kb/193656.  

**you can review this step in this youtube video:  http://youtu.be/vXorg52gywc 

Tips #29: Publish to cloud  

Autodesk 360 provides an online storage, sharing, and viewing service for your content. You can access 
your Autodesk 360 documents anytime, from anywhere, when you sign in to your account. Sign in to 
Autodesk 360 at http://360.autodesk.com or whenever prompted by Showcase.  

Once signed in, you can use the Publish drop-down box in the Publish window to specify that your 
output go on your local computer, the Autodesk 360 cloud, or both. 

Important things to know about: 

 When publishing a web presentation to the cloud. Publish directly within the root folder. DO 
NOT move the web presentation to any sub folder otherwise the presentation will not work. 
Web presentation publish within the root folder will load properly on mobile devices ( I have 
tested it personally on both my iphone and ipad) 

 JPG images is the recommended format to publish to the cloud as it is compressed and will take 
little storage. JPG images will also display automatically when browsing the document 

 You won’t be able to play published video from the cloud. Videos will need to be downloaded 
to be watch. As a suggestion, you can easily publish your video to YouTube (used the unlisted 
feature if you want to keep the video private) and send the link to your customers. 

 Some browser might work better than others with the cloud. I personally use goggle chrome. 
 

View a jpg image from my cloud: http://a360.co/1bP2EB1 
View a tiff image(notice the size difference between the JPG and TIFF image): http://a360.co/17W9XkK 
View a web presentation: http://a360.co/1cto70g 
View a video(this one needs to be downloaded for viewing): http://a360.co/15yGz3P 
View a video on YouTube: http://youtu.be/64xokVjWNFA 

http://support.microsoft.com/kb/193656
http://youtu.be/vXorg52gywc
http://360.autodesk.com/
http://a360.co/1bP2EB1
http://a360.co/17W9XkK
http://a360.co/1cto70g
http://a360.co/15yGz3P
http://youtu.be/64xokVjWNFA
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Tips #30:  Creating an image for post-production with Adobe Photoshop 
Rendering your images in Showcase is fast and can give you great quality renders, but it doesn’t have to 
stop there! You can always bring your render in third party software (Photoshop as an example) and 
enhance the images further.  
 
To do so, it is always recommended to save your images as a .TIFF or PNG as both options will give you 
options to save with alpha channel.  Having an image with alpha channel will allow for easy compositing 
such as replacing the environment.  
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** Saving in the hardware mode in 2013 will correctly save the alpha channel (in TIFF), but when in ray-tracing mode, as you’ve noticed, the 
alpha is lost.  The work around is to save and image in both mode (hardware and Ray traced) and used the alpha channel from the hardware 
rendering .tiff image.  

If you have Autodesk® Showcase™ 2014, you can publish Adobe Photoshop images (.PSD files) when 
using ray tracing. PSD output also includes the ability to:  

 Split objects, shadows, and environments into separate layers  

 Not create/include alpha for transparent objects in the object layer; this means that transparent 
objects, such as glass, will not be transparent against the image background.  

 

When publishing TIFF files, there is now an option to isolate an object using the alpha channel.  
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Look at this inspirational video from Samuel Plante to find out more about the Photoshop workflow: 

http://youtu.be/fxFIgsLsiEs 

 

For more tips and tricks, make sure to register to my YouTube channel: @LandryMarion 

Thank you 

Marion Landry 

 

http://youtu.be/fxFIgsLsiEs
http://www.youtube.com/user/LandryMarion

